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This document provides basic instruction on how to capture and convert existing content from popular 
presentation packages like Microsoft PowerPoint© and Apple’s new Keynote© that support most 
instructor-led training efforts used in business and education today.  Once captured, this converted 
content can be uploaded into OnPoint’s Course Manager software for online delivery to users over the 
web and combined with many other important training management tools like assessments, competency 
tracking, performance improvement, live event streaming, reporting and more found in Course Manager.   
 
Note:   For simplicity sake, this Quick Guide regards to all presentation-type files as PowerPoint slides 

but notes that many of the processes detailed herein also apply equally to other commonly 
used PC-based presentation packages. 

 
Each section provides an overview of the various methods and utility options you can employ with Course 
Manager to prepare and manage your assets within the OnPoint Learning Suite environment.  In many 
cases, there will be several different ways you can approach your content creation and cataloging 
requirements.  As with anything, experience and testing will help you understand which methods to use at 
which times.   
 
Feel free to contact the OnPoint support team for assistance in answering any of your content creation 
questions. 
 
A.  Importing Existing Content from Microsoft PowerPoint 
 
There are many, many ways for course authors to process existing content from an existing Microsoft 
PowerPoint (“PPT”) presentation, the most popular desktop presentation tool used today.  The resulting 
file types that can be output from PowerPoint or any of the highlighted tools mentioned herein range from 
sets of related HTML files to a series of image files to one or more Flash animation files.  The preferred 
method you take depends on what you’re attempting to accomplish in terms of user presentation and the 
tools you have and feel comfortable using.   
 
The table below provides a high-level overview of the various ways you might convert PowerPoint (or 
similar presentation content) into Asset files that you can upload or associate with Course Manager: 
 
PowerPoint Object:    OnPoint Translation: 
1. Bulleted text from a PPT Slide  Copy/Paste Text into a new OnPoint Text Asset 
2. Complete PPT Slide    Output/imported as a new OnPoint Image Asset 
3. Entire PPT Presentation  Output from PPT as HTML presentation 
4. Entire PPT presentation   Output as an Impatica© file 
5. Entire or portion of PPT presentation  Output as a Camtasia Studio© Flash file 
6. Entire or portion of PPT presentation  Output with OPCT as a Camtasia Studio© Flash file 
7. Entire or portion of PPT presentation  Output as an Adobe Acrobat/PDF file 
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1.   Cut and Paste Bulleted Text from a PowerPoint Slide 

 
You may cut and paste text directly from a PowerPoint (or similar) slide into the Course Manager’s text 
editor.  To do this, you must first: 
 

Create an Asset in Course Manager: 
 

1. Under CONTENT, select Assets from the pull-down menu. 
2. Click the Add-Asset Button. 
3. Provide an Asset Name. 
4. Click the Save Button. 
5. The asset record will appear.  Notice that the system has assigned an Asset File name 

automatically. 
 

Now cut and paste text: 
 

1. Switch to your presentation application. 
2. Block select the desired text from your PPT slide and perform a block copy (by pressing 

block/right-click/Copy, or by pressing CTRL-C on your keyboard). 
3. Switch back to Course Manager, to the Asset you created (as described above).  On the Asset 

Type field, click the Edit-Text Button.  A text editor will appear. 
4. Click inside the text box, then block paste (by pressing right-click/Paste, or by pressing CTRL-V 

on your keyboard).  Your text will appear inside the text box.  You may now use the editor to 
change the text as desired. 

5. Note:  If the PowerPoint text is a bulleted list, the bullets will not copy over into the text editor; you 
will need to add the bullets back in once the text has been copied, by using the text editor’s bullet 
command. 

6. Click the Save Button.  The Asset record will reappear. 
7. Click the Refresh Button.  Notice that the word “Text” now appears in the Asset Type field. 
8. The Asset is now active. 
 
Optional: 
 
Click the Preview Button to review the Asset if you wish.  Click the Close Button when finished 
previewing. 

 
You may edit the text by: 
    
1. Select the Edit-Text button on the Asset page.  The text editor program will load. 
2. Click the Load Text button. 
3. Edit the text as desired. 
4. Click the Save Button. 
Click the List Button to return to a list of all Assets. 
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2.   Importing a Single PowerPoint Slide 
 

[NOTE:  Please refer to separate OnPoint Capture Tools Suite (“OPCT”) documentation for 
detailed instructions on how to use our fully-integrated desktop-based utilities to streamline 
both static and motion slide capture].   

 
Follow the instructions to capture and output your PowerPoint slide selections using the OPCT utilities.  
The resulting files (JPGs, GIFs or PNGs) are now image files that can be uploaded normally as Image 
assets.  Alternatively, you can also use other standalone tools like SnagIt (from TechSmith), HyperSnap 
from Hyperion or SnapzPro for Macintosh from Ambrosia software to capture PowerPoint slides as 
images you can import into Course Manager.  Once you’ve acquired your selected images using one of 
these tools, add them to Course Manager either as single assets one-at-a-time or en mass using the 
Administration Import Course wizard as described below: 
 
Single Asset Import: 
 

Create a new Single Asset: 
 
1. In Course Manager, select CONTENT, and cursor down to Assets on the pull-down menu. 
2. Click the Add-Asset Button. 
3. Provide an Asset Name. 
4. At the Upload File line, select the Browse… Button and locate the new image file you just 

created.  Double click on the file, and it will be uploaded into the Asset. 
5. At the Asset Type field, select Image from the drop down list. 
6. Select a proper Asset Size for your imported image.  This does not have to correspond to the 

actual size of the image but the closer the better.  You can pick from any of the “t-shirt” sizes or 
specify your own custom asset size. 

7. Click the Save Button. 
The Asset record will appear.  

8.    Click the Refresh Button.  Notice that the word “Image” now displays in the Asset Type field. 
The Asset is now active. 

 
Optional 

 
Click the Preview Button to review the Asset if you wish.  Click the Close Button when finished 
previewing.  
 
Click the List Button to return to a list of all Assets. 

 
Mass Asset Import: 

 
Prepare Image Files for Upload 
 
1. Gather the image files you wish to import into a folder/subdirectory on your hard drive/server.  

Make sure that each of the files has as clear, concise name.  It makes sense to rename the files 
with the actual assigned slide name they carried in PowerPoint.  It may also make sense to 
append each file name with a numeric prefix that will help in ordering them in your folder, your 
ZIP package and ease sequencing considerations when performing a mass import. 

a. For example, file names like “01_TitleSlide.jpg” and “02_Agenda.jpg” will greatly facilitate and 
speed up the mass import process.   

2. Add all your files into a ZIP package.   
 
Step #1 - Import Image Assets En Mass into Course Manager 
 
1. Login to Course Manager as a Content Administrator or Site Administrator 
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2. Under ADMINISTRATION, Select Import / Export from the drop down menu list. 
3. From the Import section, select “Import Course”. 
4. From the Upload Zip File, select the Browse… button and locate the ZIP package you created.  

Double click on the file, and hit the Continue button. 
5. The file will then be uploaded to Course Manager.  This action will take a few seconds to a few 

minutes depending on the number of images in the ZIP package and your connection speed. 
 

Step #2 – Select Existing or Create a New Course 
 
1. Once you’ve uploaded your import/zip file, you will have two options:  to create a new Course, or 

to assign the new content to an existing course. 
 

Option 1:  Create a New Course 
 

The system defaults to the “Create a new course” option.  Notice that the radio button New 
Course is selected, and the new course name is displayed as the existing zip file name. 

(a) Edit the Course name as desired. 
(b) Choose a Category from the drop-down list. 
(c) Specify a Topic Name that the new slides will fall under. 

 
- OR - 

 
Option 2:  Add Content to an Existing Course 
 
To add content to an existing course: 

(a) Click the radio button on the desired Existing Course name instead.  [Do not fill 
in Category or Topic Name, as these will be determined in Step #3]. 

 
Step #3 – Define Your Pages 
 
You can now define the Page-level settings that each imported image will follow: 
1. Select Asset Size from the drop-down list (this should be fairly consistent with the size you 

specified on export from PowerPoint or used with your capture tools). 
2. Select the default Page Layout from the drop-down list of options.  Center works best. 
3. Choose a background color from the Style Sheet drop-down list. 
4. Note that each new image appears as a named page in the table at the bottom of the screen. 

 
[NOTE:  An Asset was created for each image that was imported, and a new Page will be created 
for that image based on the layout information just entered above. You may want to re-name 
each Page to be more descriptive by editing the default imported Page name.] 

 
5. Assign these new Pages to specific existing Topics.  Use the Topic Name drop down and select 

the Topic desired. 
 

[NOTE:  the Topic selection marked by a quotation (“) means “same as above.”]  

6. Click the Continue Button.  All imported images will be imported as specified. 
 
You may now go to CONTENT and review or edit your imported materials. 
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3.  Export PPT Presentation as HTML and Display Using the URL Asset Type 
 

One of the easiest and most powerful ways to present a PowerPoint presentation online is to use 
Microsoft’s own “Save as Web Page” functionality found in the more recent versions of PowerPoint.  The 
nice part about this export/import method is most of the formatting, slide transitions, and screen animation 
that’s been created in PowerPoint can be made part of a web-based slide presentation.  Later versions of 
PowerPoint (e.g., Office XP and Office 2004) even provide very good support for supporting any 
accompanying audio and video clips that may have been part of the original PowerPoint presentation.  In 
general, the resulting output of this “Save As…” functionality is a master index file and a folder that 
contains all of the other imagery and media components you’ve elected to output.  You can even specify 
that the outputted presentation include an interactive table of contents that can be clicked on to 
seamlessly move from slide to slide.  Learners can even run these presentations at “full screen” size 
during playback creating a more engaging and immersive learning experience.   
 
Next, the output files that have been created (both the master file and the associated media folder we will 
term the “HTML Package”) then need to be uploaded to an Internet-accessible web server or to Course 
Manager as an External Asset (referenced internally but stored outside of the OnPoint repository).  Once 
uploaded, it’s easy to create an external asset in Course Manager that refers to the physical address 
where the master index file for the outputted presentation can be accessed via a web browser and assign 
that URL type asset to a Page, Topic and Course.   
 
Exporting Your Presentation from Microsoft PowerPoint (using PowerPoint version 2002) 
 

Step #1 - Using Microsoft’s “Save as Web Page” Feature 
 
1. Open the PowerPoint presentation you wish to take online. 
2. Select “Save As…” from the File Menu and change the “Save as Type” from “Presentation (*.ppt)” 

to “Web Page (*.htm, *.html)” and provide a new name (if desired). 
3. Click the Publish button and the Publish as Web Page dialog box will appear. 
4. Most of the default settings in PowerPoint 2002 are fine but you can fine-tune your output by 

clicking the Web Options button.  Typical fine-tuning would include: 
a. Under the Appearance tab, check “Add Slide Navigation Controls” and “Show Slide Animation 

While Browsing”. 
b. Under the Browsers tab, update your Target Browsers pull-down to use the most current IE version 

you can; the higher the version, the better the slide control and appearance.  Try IE 5.0 or higher to 
start. 

c. Under the Pictures tab, change the Screen size to 800x600; this works best with the Content 
Viewer on most displays. 

d. Click the OK button to commit your parameter changes.  
5. Update the “Publish a Copy as” dialog boxes to point to the proper directory and file name for 

your intended output. 
6. Click the Publish button to begin the export process.  Your computer will now generate all of the 

necessary files including the media elements you had in your original PowerPoint presentation. 
 

Note:   Be aware of the fact that web-based delivery will have an effect on the overall playback 
performance of your presentation vs. running it from your local workstation.  However, 
you can largely mitigate the impact of the web’s limited throughput speeds by making 
sure that all rich media asset files included in your original PowerPoint presentation are 
size-optimized for web delivery.  For instance, audio clips should be saved as mono MP3 
files at 11Hz (about 30KB/minute) rather than stereo Wave files at 44Hz (about 400 
KB/minute) and Flash animations run fine at small sizes and slower frame rates/sec 
making them much smaller as well. 
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Step #2 – Option A: Upload HTML Package to a Web Server/Host 
 
1. Speak to your organization’s IT department or web administrator about gaining file-level access to 

an Internet-connected web server.  Follow their recommended steps to copy or transfer (using 
FTP) your HTML Package from your local workstation to a web-accessible directory on your web 
server 

a. For instance, you’ll need to be able to copy your HTML Package to a subdirectory you 
create on your web server and specify the relative URL/path name to those files 

 
 www.bigcompany.com/e-learning/module_1/index.html 
 

where “bigcompany.com” is your company’s domain name, “e-learning” is your content 
directory, “module_1” is your subdirectory and “index.html” is the launch file for your 
outputted PPT presentation.   
 

2. Once your files have been uploaded to a web server, login to Course Coordinator, Content 
Administrator or Site Administrator. 

3. Under CONTENT, select Assets from the pull-down menu (and set a Filter if desired). 
4. Click the Add-Asset Button. 
5. Provide an Asset Name and Description. 
6. Select Asset Name = “URL” from the dropdown menu. 
7. Selection the “Create Asset without Associated Asset File” Asset File Type. 
8. Enter the exact URL for the key file stored on your web server. 

a. http://www.bigcompany.com/e-learning/module_1/index.html 
9. Specify the Category and Asset Size for your new external URL asset. 
10. Click the Save Button.  
11. The asset record will appear.  Notice that the system has assigned an Asset File name 

automatically.  Click Preview to view the new URL Asset in a window and check its size. 
12. Assign the new Asset to a Page, Topic and Course as needed. 

 
Step #2 – Option B: Upload HTML Package to a Course Manager as an External Asset 
 

NOTE:  This option is only valid for hosted or enterprise customers who have purchased 
OnPoint’s Cached Content Server service. 

 
1. Make sure the HTML Package for your exported PowerPoint presentation has been added to a 

ZIP Package file. 
2. Login to Course Manager as a Course Coordinator, Content Administrator or Site Administrator. 
3. Under CONTENT, select Assets from the pull-down menu (and set a Filter if desired). 
4. Click the Add-Asset Button. 
5. Provide an Asset Name and Description. 
6. Select Asset Name = “URL” from the dropdown menu. 
7. Select the “Multi-File Asset” Asset File Type. 
8. Provide the name for an Asset Subdirectory on the Cached Content Server.   
9. Browse for and select for the ZIP Package containing the HTML Package. 
10. Specify the Category and Asset Size for your new external URL asset. 
11. Click the Save Button.  When all of the above field information has been committed to the 

database, your ZIP Package will be uploaded to your External Assets Repository and your HTML 
Package will be extracted. 

12. The asset record will appear.  Notice that the system has assigned an Asset File name 
automatically.  Click Preview to view the new URL Asset in a window and check its size. 

13. Assign the new Asset to a Page, Topic and Course as needed. 
 

http://www.bigcompany.com/e-learning/module_1/index.html
http://www.bigcompany.com/e-learning/module_1/index.html
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4.  Export PPT Presentation as an Impatica for PowerPoint Java File 

Impatica for PowerPoint © from Impatica, Inc., with a street price of around US$500, is a self-contained 
conversion utility that outputs existing PowerPoint presentations into very compact web presentation files.  
In general, Impatica for PowerPoint operates with the sample simplicity of PowerPoint’s own “Save as 
Web Page” function discussed above but the resulting output files are actually highly compressed and, 
therefore, perhaps more “portable” than the “HTML Packages” generated above.  (NOTE:  According to 
the company, an Impatica file is typically 95% smaller than the PowerPoint HTML files due to the use of 
Java encoding).  Instead of an HTML Package that contains a key file and perhaps dozens or hundreds 
of separate image and media files in a folder, an Impaticized presentation is self-contained with only one 
output file to manage that is played back with a browser-based plug-in Player that’s downloaded to the 
user when they request that Asset.  Playback is solid and most all slide transition and animation features 
are supported. 

NOTE:  You can download a free evaluation copy of Impatica for PowerPoint from Impatica’s web 
site at www.impatica.com.  The evaluation version stamps your output with a watermark 
file but you can easily test the program’s many capabilities and ease of use.    

Step #1 - Using the Impatica for PowerPoint Utility  
 
1. Open the Impatica for PowerPoint application and ADD the PowerPoint presentation (or a 

series of multiple presentations) you wish to “Impaticize” and upload to Course Manager in the 
“Source PowerPoint Files” window.   

2. Most of the default settings in Impatica for PowerPoint are fine but you can fine-tune your 
output by adjusting the following:  

e. In the “Choose Your Translation Settings” section and under the “Slide Show” tab, click the “Include 
Playback Controls” setting if you’ve got several slides you’re including in your Impatica file. 

f. In the “Choose Your Translation Settings” section and under the “Media & Animations” tab,you’re 
your jpeg image quality to 70%. 

g. Choose your output directory and file name if different than your source PowerPoint file. 
3. Click the Translate button to begin the export process.  Your computer will generate two files in 

the directory you specified including a “*.IMP” file and a “*.HTML” file; Course Manager only 
needs the “*.IMP” file to be uploaded and saved as an Asset.   

 
Step #2 – Upload Impatica File to Course Manager 
 
1. Under CONTENT, select Assets from the pull-down menu (and set a Filter if desired). 
2. Click the Add-Asset Button. 
3. Provide an Asset Name and Description. 
4. Select Asset Name = “Impatica” from the dropdown menu. 
5. Select the “Upload Single Asset File” Asset File Type. 
6. Browse for and select the Impatica “IMP” file from your local HDD or file server.  Remember, you 

do not need the generated HTML file. 
7. Specify the Category and Asset Size for your new external URL asset.  We recommend using a 

the Extra Large (800x600) setting for best viewing.   
8. Click the Save Button.  
9. The asset record will appear.  Click Preview to view the new Impatica Asset in a window and 

check its size. 
10. Assign the new Asset to a Page, Topic and Course as needed. 

 
 

http://www.impatica.com/
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5.  Export PPT Presentation as a Camtasia Studio Flash File 

Camtasia Studio 2 © from TechSmith Corporation, with a street price of around US$300, is a complete 
solution for recording, editing and publishing screen capture videos that can be output as Flash 
animations or streaming video clips (in MPEG or QuickTime formats).  The Camtasia Studio suite of 
tools is easy to learn and use and makes extensive use of Production Wizards that assist in both the 
capture and output processes.  The best use of Camtasia is capturing onscreen motion that may be found 
in your PowerPoint presentation but also works in capturing these screen actions in other applications so 
it makes a great tool to create tutorials about how to use other applications and computer-based 
processes.  Notably, Camtasia may be the only way to capture highly complex animations found in some 
PowerPoint presentations that don’t convert well using other translation tools like Impatica for 
PowerPoint or RLOX Xtractor ©  from Multimedia Design Corp.   

Finally, OnPoint’s own static and motion capture tools, called the OnPoint Capture Tools Suite or 
OPCT, uses capture components licensed from TechSmith that leverage the power and flexibility of the 
Camtasia Studio offering.  We highly recommend these tools to all our customers and user.     

NOTE:  You can download a free evaluation copy of Camtasia Studio 2 from TechSmith’s web 
site at www.techsmith.com.  The evaluation version is actually a fully functional version 
but will timeout after 30 days unless licensed in full.  There are no watermarks applied.    

Step #1 - Using the Camtasia Studio Recorder Capture Utility  
 
1. Open the Camtasia Recorder (first option on the Camtasia Studio pallet) and set your “Input” 

settings found under the “Capture” menu selection.  You can choose to capture the full screen 
area or a fixed window size. 

2. Select your screen recording options as needed via the icon library on the recorder panel 
including whether or not you want to capture audio (via a PC-attached microphone), cursor 
movements, keyboard sounds and clicks, or mute other internal sounds. 

3. Set your “Output” settings found under the “Capture” menu selection and select “File”.  The 
resulting file you create will be generated in an AVI format. 

4. Most of the default settings in Camtasia Recorder are fine but you can fine-tune your output by 
adjusting the following accessed through the “Tools: Options” submenu:  

a. In the “Video Options” section and under the “AVI” tab, make sure that “Auto Configure” is checked.  
We recommend using the TechSmith Screen Capture Codec instead of the Microsoft Codec. 

b. In the “Audio Options” section and under the “AVI” tab, make sure you’re “Audio Setup” reflects the 
kind of microphone or PC-recording you have installed on your computer.  We recommend using 
the PCM Codec and an audio format of 22Hz, 16-bit stereo.  This higher rate can always be 
reduced when producing and compressing your final output.   

c. In the “Output File Name” section of the “File” tab, click the “Ask for File” radio button to insure you 
can always name and save your file wherever you need to. 

d. Click the OK button at the bottom of the Tools Options screen to save your changes. 
5. Click the Capture button to begin the recording process.  You can also set a Pause Key using F9 

to ready your computer for recording allowing you time to open the PowerPoint presentation (or 
other file) you wish to record.  When the presentation is loaded, use PowerPoint’s “Slide Show” 
function to begin your presentation in full-screen and hit F9 to start recording.  Camtasia 
Recorder will now record every screen action, all audio and keyboard actions as defined by your 
setup configuration. 

6. When you have completed your presentation, hit the F10 key to end your capture.  You will be 
prompted to name you capture file and can save it to an appropriate directory. 

 
Step #2 – Using the Camtasia Studio Producer Utility 
 

http://www.techsmith.com/
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1. Open the Camtasia Producer (second option on the Camtasia Studio pallet) and browse for the 
directory where you saved your AVI capture file generated above.  When located, a thumbnail 
icon will appear in a window next to the fold tree menu.   

2. Drag the AVI thumbnail file onto the main canvas window to begin the editing process.  You’ll 
notice that your clip now appears in the canvas window and a timeline can be seen at the bottom 
of the screen allowing you various ways to trim and edit your captured clip.  You can also insert 
new sound files if needed. 

3. Once your edits are complete, click on the video image on the main canvas and drag it up to the 
filmstrip along the top of the screen into the first square (all the way to the left).  It may make 
sense to save your edited file as a Camtasia Producer project and give it a name. 

4. To convert the edited file to a Flash animation, hit “Ctrl+W” to launch the Production Wizard and 
follow the onscreen instructions to prepare your clip for export as a Flash file (or streaming video 
file if desired; Flash files will be much smaller though).  Other typical settings you’ll want to set 
during the Production Wizard include whether or not to include a Control Strip (say “yes” if you’ve 
got lots of slides), the target delivery size of the output file (choose 800x600 or 640x480 for most 
purposes), set your frame rate (10 frames/sec is good for most purposes) and set your sound 
quality (11Hz, mono is best for most purposes).  Give your output file a name and make sure 
you’ve got the “preview” checkbox marked so you can view your output once it’s been generated 
to verify your settings.  

5. Camtasia Producer will generate two files in the directory you specified including a “*.SWF” file 
and a “*.HTML” file; Course Manager only needs the “*.SWF” file to be uploaded and saved as an 
Asset.   

 
 

Step #3 – Upload Flash File to Course Manager 
 
1. Under CONTENT, select Assets from the pull-down menu (and set a Filter if desired). 
2. Click the Add-Asset Button. 
3. Provide an Asset Name and Description. 
4. Select Asset Name = “Flash” from the dropdown menu. 
5. Selection the “Upload Single Asset File” Asset File Type. 
6. Browse for and select the “SWF” file from your local HDD or file server.  Remember, you do not 

need the generated HTML file. 
7. Specify the Category and Asset Size for your new external URL asset.  We recommend using a 

the Extra Large (800x600) setting for best viewing.   
8. Click the Save Button.  
9. The asset record will appear.  Click Preview to view the new Flash Asset in a window and check 

its size. 
10. Assign the new Asset to a Page, Topic and Course as needed. 
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6.  Export PPT Presentation as a OPCT Motion Flash File 

An alternative and simplified way to capture a PowerPoint presentation with the same results as 
described above would be to use OnPoint’s own motion capture utility, called the OnPoint Capture Tools 
Suite or OPCT, which uses a screen capture component licensed from TechSmith that leverages the 
power and flexibility of the Camtasia Studio offering.  You still need Camtasia Producer to output the 
Flash file but the capture routine is much simplified and that’s the real benefit of using OPCM.   

NOTE:  Again, you can download a free evaluation copy of Camtasia Studio 2 from TechSmith’s 
web site at www.techsmith.com.  The evaluation version is actually a fully functional 
version but will timeout after 30 days unless licensed in full.  There are no watermarks 
applied.    

Step #1 - Using the OnPoint Capture Tools - Motion Capture Utility  
 
1. Open OPCM and set your “Configuration” settings as needed.  Screen captures with OPCM are 

only full screen.  
2. Under “Video”, you can specify the video capture settings you’d like to use including whether or 

not you want to capture audio (via a PC-attached microphone), cursor movements, keyboard 
sounds and clicks, whether to optimize frame rates, to minimize the application after starting 
capture, and whether to pause after “Start” has been clicked but before actual capture begins.  All 
of these options are normally clicked except for “record cursor movements”. 

3. Under “Output”, specify your settings. You can either specify an output directory or choose to be 
prompted for a file name once a capture is complete.  

4. Click the Start icon to begin the recording process.  If your Pause setting was selected in the 
configuration settings, the utility will wait to begin recording until after you have opened your 
PowerPoint presentation and are ready to begin.  When the presentation is loaded, use 
PowerPoint’s “Slide Show” function to begin your presentation in full-screen and hit F9 to start 
recording.  OPCM will now record every screen action, all audio and keyboard actions as defined 
by your setup configuration. 

5. When you have completed your presentation, hit the F10 key to end your capture.  You will be 
prompted to name you capture file and can save it to an appropriate directory. 

 
Step #2 – Using the Camtasia Studio Producer Utility 
 
6. Open Camtasia Producer (second option on the Camtasia Studio pallet) and browse for the 

directory where you saved your AVI capture file generated above.  When located, a thumbnail 
icon will appear in a window next to the fold tree menu.   

7. Drag the AVI thumbnail file onto the main canvas window to begin the editing process.  You’ll 
notice that your clip now appears in the canvas window and a timeline can be seen at the bottom 
of the screen allowing you various ways to trim and edit your captured clip.  You can also insert 
new sound files if needed. 

8. Once your edits are complete, click on the video image on the main canvas and drag it up to the 
filmstrip along the top of the screen into the first square (all the way to the left).  It may make 
sense to save your edited file as a Camtasia Producer project and give it a name. 

9. To convert the edited file to a Flash animation, hit “Ctrl+W” to launch the Production Wizard and 
follow the onscreen instructions to prepare your clip for export as a Flash file (or streaming video 
file if desired; Flash files will be much smaller though).  Other typical settings you’ll want to set 
during the Production Wizard include whether or not to include a Control Strip (say “yes” if you’ve 
got lots of slides), the target delivery size of the output file (choose 800x600 or 640x480 for most 
purposes), set your frame rate (10 frames/sec is good for most purposes) and set your sound 
quality (11Hz, mono is best for most purposes).  Give your output file a name and make sure 
you’ve got the “preview” checkbox marked so you can view your output once it’s been generated 
to verify your settings.  

http://www.techsmith.com/
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10. Camtasia Producer will generate two files in the directory you specified including a “*.SWF” file 
and a “*.HTML” file; Course Manager only needs the “*.SWF” file to be uploaded and saved as an 
Asset.   

 
Step #3 – Upload Flash File to Course Manager 
 
11. Under CONTENT, select Assets from the pull-down menu (and set a Filter if desired). 
12. Click the Add-Asset Button. 
13. Provide an Asset Name and Description. 
14. Select Asset Name = “Flash” from the dropdown menu. 
15. Selection the “Upload Single Asset File” Asset File Type. 
16. Browse for and select the “SWF” file from your local HDD or file server.  Remember, you do not 

need the generated HTML file. 
17. Specify the Category and Asset Size for your new external URL asset.  We recommend using a 

the Extra Large (800x600) setting for best viewing.   
18. Click the Save Button.  
19. The asset record will appear.  Click Preview to view the new Flash Asset in a window and check 

its size. 
20. Assign the new Asset to a Page, Topic and Course as needed. 

 
 
Mass Import of Flash Assets 

Follow the basic instructions in the Word for performing mass imports of Flash documents.  The same 
procedures apply for the mass importation of Flash assets.  Make sure to select “Flash” as your default 
asset type. 
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7.  Export PPT Presentation as PDF File and Display Using the PDF Asset Type 
 

One of the most popular and industry standard file formats for packaging and delivering information over 
the web is exporting content saved in Adobe’s Portable Document Format or “PDF” file format.   The 
format has become so ubiquitous, in fact, that every major computer operating system vendor, including 
Microsoft, includes a free Adobe Acrobat Reader© application or browser plug-in bundled in as part of 
their standard customer offering.  The benefits of creating and distributing PDF files stem from the fact 
that almost any applications can generate native-looking print quality materials, complete with all their 
intended formatting and visual elements, and have these files read online without needing the original 
application to display them properly.  In short, Adobe PDF files are digital “printouts” of any commonly 
generated computer output that can electronically emailed or downloaded as opposed to being physically 
mailed, copied or faxed.   Standard software enables business professionals to convert any Microsoft 
Office and other paper or electronic document to reliable Adobe Portable Document (PDF) files, and send 
them to colleagues for review. 
 
Acrobat 6.0© from Adobe Systems Incorporated, with a street price of around US$300, enables business 
professionals to convert any Microsoft Office and other paper or electronic document to reliable Adobe 
Portable Document (PDF) files, and send them to colleagues for review.  For presentation files like 
Microsoft PowerPoint slides, content authors can use Acrobat to print out electronic handouts of all or 
portions of a PowerPoint presentation to be viewed in a web browser as content within an online course 
or as a means of distributing other supporting documentation for that course that can be downloaded and 
printed. 
 
The advantages of outputting PowerPoint slides as PDF files are obvious.   First, the process is very 
quick and requires almost no decisions to be made given it’s the equivalent of outputting the necessary 
content to a network printer.  Second, the content can be displayed in a browser window as part of a 
course but also can be expanded to view at full screen, viewed as a series of thumbnail images, printed 
out and even stored locally serving as hard copy documentation for those who require that.  Finally, the 
content can not be tampered with or changed in any way once it has been published as a PDF file.   
 
There are a few disadvantages of outputting PowerPoint slides in PDF format including the fact that all 
included electronic pages in a PDF file are static and can’t contain any slide animations or rich media files 
that may have been included in the original materials.  Second, the more slides there are in the original 
presentation, the larger the resulting PDF asset is going to become, and the harder it is to load and 
navigate around when viewed via a web browser.  It makes sense to create short PDF output files with 
one to six pages each (think “chicklets”) instead of one large file with 30 slides (a chunk).  Also, using the 
chicklet method allows you to intersperse topic-level quizzes or tests and intermix rich media pages within 
the same course thus adding to the overall online experience. 
 
Exporting Your Microsoft PowerPoint Presentation as a PDF File  
 

Step #1 – Printing to PDF from Inside Microsoft PowerPoint  
 
1. Open the PowerPoint presentation you wish to take online in PDF format. 
2. Once your presentation has been displayed, select the slides you’d like to output as a “PDF 

Chicklet” and select “Print” from the “File” menu in PowerPoint; you will then be presented with 
PowerPoint’s standard Print Dialog Box. 

3. Open the Printer “Name” dropdown box and select “Adobe Distiller” from the presented choice list 
(Note:  You must have a copy of Adobe Acrobat installed in your computer for this to appear). 

4. Most of the default settings in the “Adobe Distiller” print driver are fine but you can fine-tune your 
output by clicking the Properties button.  Typical fine-tuning would include: 

a. Under the Layout tab, select “Landscape” orientation to make sure your slides appear as slides in 
the PDF file.   
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5. Select the “Print Range” you’d like to output and click the OK button to begin the output process.  
Your computer will now generate the PDF containing static image copies of all of the slides you 
selected for inclusion in your PDF chicklet. 

 
Note:   If you make sure all of the Properties fields found under the File menu have been filled 

out for your PowerPoint presentation section before you output your PDF file, this 
information will be included in the Document Summary that accompanies the generated 
PDF file.  This may be important for reasons of copyright and support later for those 
users who download, save and printout PDF assets while talking an online course.   

 
Step #2 – Upload PDF File to Course Manager as PDF Asset 

 
1. Login to Course Manager as a Course Coordinator, Content Administrator or Site Administrator. 
2. Under CONTENT, select Assets from the pull-down menu (and set a Filter if desired). 
3. Click the Add-Asset Button. 
4. Provide an Asset Name and Description. 
5. Select Asset Name = “PDF” from the dropdown menu. 
6. Select the “Single File Asset” Asset File Type. 
7. Browse for and select for the PDF file you wish to upload. 
8. Specify the Category and Asset Size for your new PDF asset.  You can pick from any of the “t-

shirt” sizes or specify your own custom asset size.   
 

NOTE:  PDF assets should tend to be larger in size (XL or Jumbo) and can also be opened full-
screen in the Content Viewer with the “Open in New Window” link that automatically gets inserted 
onto every OnPoint Page that contains a PDF asset. 

 
9. Click the Save Button. 
10. The asset record will appear.  Notice that the system has assigned an Asset File name 

automatically.  Click Preview to view the new PDF Asset in a window and check its size. 
11. Assign the new Asset to a Page, Topic and Course as needed. 
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